
   

All faculty, staff, and students have access to the Cisco WebEx videoconferencing service.   You can use WebEx to host 
and join meetings that can accommodate up to 1,000 participants. In a WebEx virtual meeting room, you can share any 
combination of audio, video, and the content on your screen. WebEx Rooms can also be recorded for future viewing.  

Click on the text to navigate  

WebEx Account Verification 

Joining a Webex Meeting  

 WebEx Meeting Invitation 

 Join a Webex Meeting from a Computer or Laptop 

Hosting a Webex Meeting 

 Hosting a Personal Room Meeting from a Computer or Laptop 

 Hosting a Scheduled Meeting 

Connecting WebEx Audio/Video  

 Connecting to Audio/Video before a meeting  

 Changing Audio settings during a meeting  

Join a Webex Meeting by Phone 

Sharing Content 

Scheduling WebEx Meetings  

 Scheduling using uconnhealth.webex.com website 

 Scheduling using Webex Outlook Integration  

 Installing Outlook Integration (Webex Productivity Tools) 

 Scheduling meetings on behalf of someone 

 Assigning alternate hosts 

Installing WebEx Mobile Application 

WebEx Security: 

 Securing your WebEx Meeting 

 Adjust the Personal Room Automatic Lock 

 Managing Participants 

Audio Conference 

Annotate 

Breakout Sessions 

Change Profile Name and Picture 

Polling 

Raising Hand 

Virtual Backgrounds 

WebEx Guide 
uconnhealth.webex.com 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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To have full capabilities within your WebEx account for scheduling meetings and changing permissions you must verify 

your account first. This procedure only needs to be done one time and takes about one minute to complete.  

 

Verification Process  

1. Sign in at uconnhealth.webex.com with your @uchc.edu email and password (click the blue Sign In button at the top 

right of your screen)  

2. Click on Send Verification Email (it should say sent after you click on the link)  

3. Sign in your @uchc.edu email  

4. Find the verification email and open it  

5. Click on the verification link. This should open a web browser and say you have been verified.  

6. Navigate back to uconnhealth.webex.com and Sign in and you should see your personal room with your name. See 

the figure below.  

Verification 

Example of a Personal Room Home Page: 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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Joining a WebEx Meeting (invitation explained) 
Note: Cisco recommends using Google Chrome as your browser for the best WebEx experience. 

1. Login to your email. 

2. Navigate to your Email Inbox or Calendar and open the WebEx Invitation email.  

PC users: If you accept the invitation it will go to your Sent folder and will also be on your calendar at the date/time specified.  

Mac users: If you accept the invitation it will go into your Junk folder and will also be on your calendar at the date/time specified.  

3. This invitation will allow you to join from a computer, laptop, smartphone, phone line or video conference system. Choose your 
method: 

Important: Invitations may look different than the examples shown below. Follow the instructions provided on your invitation.  

Join by Computer/Laptop: Select Join meeting (green icon)  

Join by phone: Dial the Join by phone number provided and enter the access code when prompted.  

Join by Video system: Using the room’s touch panel select Video conference, then type in the Join by video system address by us-
ing the number/letter keypads. Then select Call. 

Example email invitation #1: 

Join by Computer/
Laptop 

Join by Phone 
(dial in) 

Join by video 
system 

Meeting # (access code) 
Meeting password 

Join by mobile device (auto dial 
in with number and passcode) 

Example email invitation #2: 

Join by video 
system 

Join by Computer/
Laptop 

Join by Phone 
(dial in) 

UCONN Health IT's Personal Room 
https://uchc.webex.com/meet/UCONN | 800921123 
 
Join by video system 
Dial UCONN.uchc@webex.com 
You can also dial 123.456.2.68 and enter your meeting number. 
 
Join by phone 
+1-415-655-0003 US Toll 
Access code: 800 921 123 
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3. If this is the first time you’re joining a webex meeting, you will be prompted to download and install Webex Meetings app (the 
app will download automatically). We recommend doing so at this time for the full Webex experience. 

Joining a Webex Meeting on a Computer/Laptop 
1. Navigate to the Webex invitation you received. If you did not accept the invitation, it will be in your inbox. 

PC users: If you accepted the invitation it will go to your Sent folder and will also be on your calendar at the date/time specified.  

Mac users: If you accepted the invitation it will go into your Junk folder and will also be on your calendar at the date/time specified.  

Open the calendar meeting and you will see the invitation. 

2. Select the Join Meeting (green button) 

Optional: If you do not want to download and install the application do the following:  

A. Cancel the download in order to continue to the Web App. 

B. Wait up to 10 seconds after you cancel the download, or until the "Having trouble downloading the app" message 
appears. Click on Join from your browser. See image below. 

4. A meeting preview screen will launch. Select your audio connection type. Preview screen below: 

Use computer audio: Will use built in or external audio source from 
your computer or laptop. 

Call in: Will provide call in information to dial in by a phone line. Au-
dio will not connect until you manually call in from a phone.         
(Note: After joining the meeting, call in information will be displayed)  

Don’t connect to audio: Will disconnect audio. You cannot hear or 
speak. 

Important: Webex invitations may be customized. Make sure to follow the instructions on the invitation. Generally there is a 

blue hyperlink to click to join the meeting from a computer. 
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5. Select your microphone, speaker, and camera. When using a webcam or laptop, Webex will automatically choose the default 
settings for your mic, speaker, and camera (not in all cases).  

Note: Webex will remember the settings you chose for your previous meeting. 

Optional: Before entering a meeting, you may choose to have your microphone on or muted and your video (camera) on or 
stopped. Select Mute to mute your mic. Select Stop video to stop your video (camera). You can turn your microphone and camera 
on and off at any time during the meeting. 

Note: You can leave your mic muted and press and hold the “spacebar” to talk. Let go of the space bar to remain muted.  

Optional: Before entering a meeting, you may choose to test your microphone and camera to ensure they are working properly.  

Speaker: Select Test and you should 

hear a sound playing. If you do not hear 

sound, make sure your device volume is 

turned up and not off or muted. If you 

need to, try selecting a different speaker 

option in the settings (if available).  

Microphone: Select Test and it will start 

recording a test for a few seconds. Start 

talking as you would normally be talking 

in your meeting. The system will playback 

the recording so you can hear yourself. If 

you do not hear yourself make sure your 

mic is on and not muted. If you need to, 

try selecting a different microphone    

option in the settings (if available).  

6. Select Join Meeting when you are ready.  

Settings Example: 

Mic: On 
Cam: On 

Mic: Off 
Cam: Off 
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Hosting a Webex Meeting on a Computer or Laptop 

1. Sign in at uconnhealth.webex.com. Webex recommends using google chrome (windows) or safari (mac). 

Webex Personal Room 
Your Webex Personal Room is your own virtual conference space that you can use for meetings at anytime. Your Webex Personal 
Room is always available, you don’t have to book it, and you always know where to find it. When you invite people to your Person-
al Room, they can easily find your meetings since the link to your meeting location never changes.  

2. Select Start a Meeting 

Start a Personal Room Meeting from uconnhealth.webex.com website 

2. A preview screen will launch. Select your audio and video settings. Click here for help selecting audio and video settings. 

3. Select Start Meeting. A meeting will launch and attendees are able to join now.  

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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1. Open Cisco Webex Meetings app 

Start a Personal Room with the Desktop Application 

2. Select Start a Meeting. 

Note: The Start a Meeting can only start a Personal Room meeting.  

Start a Personal 
Room Meeting 

3. A preview screen will launch. Select your audio and video settings. Click here for help selecting audio and video settings. 

4. Select Start Meeting 
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Starting/Hosting a scheduled meeting 

Scheduled Webex Meeting 

You can schedule a meeting in advance. Scheduled meetings are required to have passwords and the meeting information is 

unique for each scheduled meeting (unless using recurring scheduling option). Scheduling helps to ensure a secure meeting. 

1. Sign in at uconnhealth.webex.com. Webex recommends using google chrome (windows) or safari (mac). 

Start a Scheduled Meeting from uconnhealth.webex.com website 

2. Select Meetings (left side menu) 

3. If you have scheduled a webex meeting it will appear on the list of Upcoming meetings. 

Note: If you are looking for a meeting that is past the scheduled end time of the meeting, you will find it under Past.  

4. Find your meeting title (verify with date/time) and select Start.  

Note: For meeting details click on the meeting title. A new window will appear with the meeting information. You may also start 
the meeting here. 

Patient Discussion 
Betty Smile 

Business Plan 
Martin Frown 

5. A preview screen will launch. Select your audio and video settings. Click here for help selecting audio and video settings. 

6. Select Start Meeting 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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Starting/Hosting a scheduled meeting 

1. Open Outlook using the desktop application. (Click the outlook icon on your desktop) 

Start a Scheduled Meeting from Outlook 

2. Find the invitation you sent out in your inbox or sent folder 

5. A preview screen will launch. Select your audio and video settings. Click here for help selecting audio and video settings. 

6. Select Start Meeting 

3. Open the invitation and select Start Meeting.  

Note: If the invitation says Join Meeting and you are the host or a cohost you may click on the Join Meeting link and the meeting 
will start. 

Start a Scheduled Meeting from Outlook Calendar 

1. Open Outlook using the desktop application. (Click the outlook icon on your desktop) 

2. Open your outlook calendar 

3. Find your meeting invitation by the date/time and title of your meeting. Double click on the calendar meeting to open it. 

4. Select Start Meeting. 

Note: If the invitation says Join Meeting and you are the host or a cohost you may click on the Join Meeting link and the meeting 
will start. 

5. A preview screen will launch. Select your audio and video settings. Click here for help selecting audio and video settings. 

6. Select Start Meeting 
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1. Open Cisco Webex Meetings app 

Start a Scheduled Meeting with the Desktop Application 

2. Select Start a Meeting. 

Note: The Start a Meeting can only start a Personal Room meeting.  

Start a Personal 
Room Meeting 

Start a Scheduled 
meeting 

3. A preview screen will launch. Select your audio and video settings. Click here for help selecting audio and video settings. 

4. Select Start Meeting 
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Audio/Video Settings 

Choose your Audio and Video Settings Before you Join a Webex Meeting or Event 

Choose how you want to connect to the audio, mute or unmute your microphone, and turn on or turn off your video before you 

join a meeting or event.  Click here for a video guide. 

1. Once you have clicked a link to a join a webex meeting a preview screen will appear. In this screen you may choose your audio 

and video settings before you enter the meeting. 

2. If you are choosing to Use Computer Audio , select the audio options arrow to change your audio settings (microphone and 

speakers)  

2. Select your audio connection type.  

Use computer audio: Will use built in or external audio source from your computer or laptop.  

Call in: Will provide call in information to dial in by a phone line. Audio will not connect until you manually call in from a phone .         
Note: After joining the meeting, the call in information will be displayed in a popup window. Follow the instructions provided. 

Don’t connect to audio: Will disconnect audio. You cannot hear or speak. 

3. Select your camera.  

Select your Speaker: 
Use system setting: Uses whatever the system 
default settings are set to. 
Speaker: Uses built in or external speakers. 
Headphones: Uses headphones that are 
plugged into the computer. 

Select your Microphone: 
Use system setting: Uses whatever the system 
default settings are set to. 
Internal Microphone: Uses built in microphone 
(generally on laptops). 
External Microphone: Uses a microphone that is 
plugged into the computer. 

https://help.webex.com/en-us/nt2ig0y/Choose-Your-Audio-and-Video-Settings-Before-You-Join-a-Webex-Meeting-or-Event-Slow-Channel
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4. Test your audio settings to ensure your microphone and speakers are working before you enter the meeting. 

 A. Select Test speaker and microphone on the preview screen 

 B. Select Test next to the speaker settings and a chime will play.  

 If you do not hear the test sound make sure your speakers are on and your computer sound isn’t muted. Try changing 
 the speaker setting to another device such as headphones. There may be more than one option for selecting speakers. 

 C. Select Test next to the microphone settings. Start speaking into your microphone and webex will record your voice 
 and then play it back to you after five seconds.  

 If you do not hear your voice played back ensure that your microphone is not muted, fully plugged in, and your speakers 
 are working (so you can hear your voice played back). There may be more than one option for selecting your microphone. 

Select Test to test your speakers or 

headset. A short audio clip will 

play (repeating chime).  

Select Test and start speaking into your 

microphone. Webex will record your 

voice for five seconds then the record-

ing will be played back to you. 

5. Optional: Before entering a meeting, you may choose to have your microphone on or muted and your video (camera) on or 
stopped. Select Mute to mute your mic. Select Stop video to stop your video (camera). You can turn  your microphone and camera 
back on during the meeting. You can mute/unmute your mic and start/stop video whenever you want during the meeting. 

Note: You can leave your mic muted and press and hold the “spacebar” to talk. Let go of the space bar to remain muted.  

Mic: On 
Cam: On 

Mic: Off 
Cam: Off 
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Change your Audio Settings During a Webex Meeting or Event 

1. Select Audio & Video at the top of the meeting window and then select Speaker and Microphone Settings... 

2. Select the speaker options to select a different speaker. 

Change your microphone or speaker setting 

3. Select the microphone options to select a different microphone. 

4.  Try testing your microphone and speaker option to ensure they are working. If your speakers or microphone aren't working, try 

testing each microphone and speaker option available in each menu. You may have several different options to try.  

Select Test to test your speakers or 

headset. A short audio clip will 

play (repeating chime).  

Select Test and start speaking into your 

microphone. Webex will record your 

voice for five seconds then the record-

ing will be played back to you. 

5. When you are ready, close the Speaker and Microphone options box. You will be in the meeting with the speaker and micro-

phone settings you just selected. 
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Change from Computer Audio to Call In or Disconnect Audio during a Meeting 

Change from Computer Audio to Call In 

1. Select Audio & Video at the top of the meeting window and then select Switch Audio... 

2. Select Disconnect. This will disconnect you from using your computer audio (speakers and microphone). 

Note: You will not be able to hear or speak in the meeting until you Call in 

3. Select Call in. (select view) 

4. The Call In window will popup with instructions on how to call into the meeting from a phone line. 

 Call the number provided (If calling from UConn Health, Dial 9 first to reach an outside line). 

 Enter the access code provided followed by the # sign. 

 Enter your Attendee ID. There is a different number for everyone in the meeting. This will match your name on your computer 
to the phone line you are calling from. (you will not show up as a  

5. You should now be able to hear the meeting audio and talk if you need to. You may mute/unmute yourself using the computer 

mute button in the meeting or your phone’s mute. Click here for audio controls for your phone. 
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You can share your entire screen with others, or choose which files and applications you want to share so you can keep everything 

else private.  

When you share your screen, everyone sees what you can see on your screen. If you have a Word document or a PowerPoint slide, 

or even a website or chat window open, they’ll see it.  

Note: Before your meeting, mute notifications and close any personal or sensitive documents. This way, you don’t have to worry 

about accidentally sharing private or distracting information.  

WebEx Content Sharing 

Share your screen 

Select  Share                          and Screen.  

Share only a specific application 

When you share a specific application, others can't see anything other than the shared application. For example, if you have your 

browser and PowerPoint open and you choose to share PowerPoint, they can't see the browser tabs you have open. But if you 

have several PowerPoint presentations open, you can switch between them and they'll still be shared. You can also edit slides as 

you share them. If you accidentally click on an application that’s not shared, they’ll see a gray screen.  

To share an application that is open, select  Share                           and select the application from the list of open applications. 

To share an application that is not open, select  Share                           and Other Applications, then click                         next to the 

application you want to share.               

Choose an 

application 
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Share a video 

Sharing video is slightly different from sharing any other type of content. That’s why Webex Meetings has a sharing mode that’s 

optimized for video.  

Note: Optimizing for motion and video isn't currently available in Webex Events. If you're using Webex Events, share your video by 

selecting Share and Share File.  

Go to Share                         , select Optimize for motion and video from the drop-down menu, and then choose the content you 

want to share. 

See what you're sharing 

When you’re sharing content, you want to make sure you’re sharing only what you want and that everyone in the meeting can see 

it. When you share your screen or an application, check what everyone else sees by opening a window that shows you what you're 

sharing. 

While sharing, go to the tab in the meeting control bar at the top of the screen and click the down arrow. 

Sharing files allows you to share a single file. It could be anything, like a document or video file stored on your computer.  

Note: If you already have the file open, share your screen or application. File sharing may not work when you're trying to share a 

PowerPoint presentation with embedded video.  

Share a file 

To share a file, Select  Share                          and Share File.  

Create a whiteboard to visually share your ideas. Whiteboards shared during a meeting aren't automatically saved. Remember to 

save your whiteboard.  

Share a whiteboard 

To share a blank work area where you can collaborate with the other meeting participants using both text and graphics tools,    

select Share                          and New Whiteboard.  

https://help.webex.com/517f0j/Share-Motion-and-Video-Content-in-Cisco-Webex-Meetings
https://help.webex.com/nytdb92/Use-the-Whiteboard-in-Cisco-Webex-Meetings
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Scheduling WebEx Meetings 

WebEx is a university-support online video conferencing system that faculty, staff, and students can use to schedule 
meetings on their personal and work computers.  

 

Get Started 
1. Go to uconnhealth.webex.com 

2. Click the blue Sign In button in the top-right corner of the window.  

3. Enter your UConn Health email to sign in.  

 
NOTE: If you are logging in from outside the UConn network (home) you may have to use: UCHC\username 

Schedule a Meeting from the UConnhealth.webex.com Website 
Once you log in, your personal room page is displayed, and you can schedule and manage your meetings.  
 
1. Click Schedule 

https://uconnhealth.webex.com/
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A. Use "WebEx Meetings Pro 1000" for the meeting type. This should be your default choice.  

B. Enter a title for the meeting.  

C. Meeting participants will need the password generated to join the meeting.  

D. Add attendees, who will receive an invitation, by entering their email addresses.  

2. Complete the fields in the Schedule a Meeting page. 

Password  
(required) 

Meeting Title 
(required) 

Optional Advanced Options 
 Click the drop down arrow for "Show advanced options"  

 Under the "Audio connection options" menu, look at the "Entry and exit tone."  This is a sound that will play when 
someone enters or leaves the room. You can have WebEx announce the name that the user has typed in, play a simple beep, 
or produce no sound at all 

 Under the "Audio connection options" menu, look at the "Entry and exit tone" This is a sound that will play when 
someone enters or leaves the room You can have WebEx announce the name that the user has typed in, play a sim-
ple beep, or produce no sound at all  

Entry and exit 
tone 
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Scheduling Options 

 Check the "Automatic recording" box if you want your meeting to start recording as soon as you begin the call  

 Check the "Exclude password" option if you opted in to protect your meeting with a password, but you don't want 
that password to be included in the automatically generated invitation email  

Booking the Scheduled Meeting 

 You may save these settings as a template if you plan on replicating this meeting  

 Click the "Schedule" button to finish your setup. Your meeting details will appear on the page. You can copy and 
paste these details into a meeting invite to share with others.  You, as the scheduler, will also receive an email confirmation 
with the meeting details, which could be forwarded to others if necessary. 
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Schedule a Meeting with Webex Outlook Integration 

If you want to schedule meetings directly through the Outlook app, follow this link for WebEx Productivity Tools. This is a WebEx 

extension that integrates WebEx capabilities into Outlook, allowing you to schedule, start meetings and create email invitations 

within the Outlook App. When selecting Schedule on the WebEx desktop app, it will launch Outlook and schedule a WebEx 

meeting. 

Barbara Holland 

BarbaraH 

1. Open Outlook (desktop application). 

2. Select which type of meeting you would like to schedule. Click here for more details on the types of meetings available. Usually 

Schedule Webex Meeting is chosen as the option used because it is the most secure option.  

Meet Now: This will start a meeting with your generic person room information. This is not a scheduled meeting.  

Schedule Webex Meeting: Secure meeting with a password, unique meeting URL and access code.  

Schedule Webex Personal Room Meeting: Standard meeting with NO password. The meeting URL and access code always remain 
the same. 

Schedule Personal Conference Meeting: An audio conference only meeting. Must be setup first to use. 

https://help.webex.com/en-us/k3jv9i/Compare-Cisco-Webex-Meeting-Types
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3. Select the settings for your meeting (our suggestions): 
 
Note: Some of the settings cannot be changed 
 
Meeting template: MC: WebEx Meetings Default 

Meeting type: WebEx Meetings Pro Meeting 

Meeting password: Use the auto generated password 

Audio connection type: WebEx Audio 

Entry and exit tone: Announce Name, Beep or No Tone 

4. Fill out the following fields in the email. DO NOT TYPE OR CHANGE ANYTHING BELOW THE AUTOMATED TEXT. This Section will 

be auto-filled with the information you enter in the fields. 

TO: Attendees, whoever you want to invite (any email)  

Subject: Meeting or Conference Title 

Location: Meeting Location (Room #) 

Start Time: Start date/time 

End Time: End date/time 

Cancel WebEx Meeting: Cancel the 

meeting you are creating 

Change Settings: To change meeting settings 

Send: This will schedule the meeting/
conference and generate an invitation 
based on the chosen settings and  
information you typed in the fields 

6. Start the meeting when you want to, it will not auto start (same for ending meeting). Start the meeting from any of your devices 

through the WebEx App or at uconnhealth.webex.com. 

 

For additional help please visit: https://help.webex.com/en-us/1h3jqab/Cisco-Webex-Productivity-Tools-WBS39-10-and-Later  

DO NOT 
TOUCH 

Fill in all 
Fields 

To change Settings 
or Cancel  

Select Send 
when ready  

5. When you are ready, select Send. This will generate the invitation and send it to all the emails you provided. 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
https://help.webex.com/en-us/1h3jqab/Cisco-Webex-Productivity-Tools-WBS39-10-and-Later
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WebEx Productivity Tools Guide 

1. Navigate to uconnhealth.webex.com and Sign In. 

2. In the left navigation bar, select Downloads. 

3. On the Downloads page, under “Cisco WebEx Productivity Tools”, select Download. 

4. Click on the file at the bottom left of your web browser to Run the installation file (.msi extension) 

5. Go through the installation wizard. If needed, contact the IT Help Desk for assistance. 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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6. Open Microsoft Outlook Application and in the Home tab (email inbox/outbox section) there should be new options to select 

next to New Email; Meet Now and Schedule Meeting. Note: If the new icons aren’t showing up, close outlook and reopen it. 

Click here for instructions on how to schedule a meeting using the productivity tools. 
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Mandatory Password Enforcement for Scheduled Meetings 
This page explains why meeting passwords are required on WebEx meetings as of 1/10/2020.  

 

Password Requirement for Scheduled WebEx Meetings 

Cisco released a security update  for WebEx meetings to enhance security and privacy. This update requires meeting 

participants to enter a password along with the meeting number when joining a meeting through the UConn WebEx log-

in: https://uconnhealth.webex.com/  

When a Password is Required 

When you schedule a meeting, it sends participants meeting information that contains a meeting link, meeting number, 

password, and host key. If participants join a meeting through the UConn WebEx login ( https://

uconnhealth.webex.com/), they need to enter both the 9-digit meeting number and password found on the invitation. 

If participants join by clicking the meeting link, either through email or the WebEx Meetings mobile app, they do not 

need to enter a meeting number or password.  

 

When a Password is Not Required 

If participants are given the direct link, they do not need to enter the password. You can access this direct link after 

scheduling your meeting on the Meeting Information page. Meeting organizers can also send the link to participants by 

adding their email to the "Attendees" field when scheduling a meeting.  

https://help.webex.com/en-us/np1t7y6/Announcements-for-the-Cisco-Webex-Meetings-Suite#id_128500
https://uconnhealth.webex.com/
https://uconnhealth.webex.com/
https://uconnhealth.webex.com/


 25 

Cisco Notes 

As announced on Nov. 6, 2019 with the  WBS39.10 release notes, starting from Jan. 10, 2020, all WebEx sites are going 

to be configured to automatically add passwords for any new meetings, events, or training sessions. Below are details 

from the WBS39.10 release notes.  

The most effective step to strengthen the security of your meetings is to create a strong password. Passwords protect 

against unauthorized attendance, so only users with access to the password can join the meeting.  

Starting from Jan. 10, 2020, all WebEx sites are going to be configured to automatically add passwords for any new 

meetings, events, or training sessions.  

Password enforcement doesn’t affect the meeting join experience of attendees. Participants can easily join a meeting by 

clicking on the URL in the meeting invitation through email or the WebEx Meetings mobile app, without requiring pass-

words. Users who enter the meeting number on the web page to join a meeting are required to enter passwords.  

Password enforcement is only available for meetings scheduled after Jan. 10, 2020.  

Cisco won’t enforce password requirements for attendees dialing in to the meeting through a phone or video device. We 

highly recommend that administrators configure their sites to require passwords for attendees joining through phones 

or video devices as well.  

To support this change, with the WBS39.10 update, site administrators can ’t disable passwords for meetings, events, 

and training sessions if their site has enabled passwords for them.  

Invite Attendees by entering 

their emails here 

https://help.webex.com/xcwws1/What-s-New-for-the-Latest-Versions-of-Webex-Meetings#id_125565


 26 

WebEx Permissions 

Allow others to schedule meetings on your behalf 

Requirements 

 Both users must be have verified uconnhealth.webex.com accounts. (see verification section) 

 Must have access to their Outlook Calendar if scheduling through Outlook WebEx integration (productivity tools). 

 Must have permission at uconnhealth.webex.com. The individual who wants to host the meeting must give permission for 

someone else to schedule meetings for them, so the host must do this procedure.  (see scheduling on behalf section below) 

Scheduling on Behalf 

1. Sign in at uconnhealth.webex.com with your @uchc.edu email and password (click the blue Sign In button at the top 

right of your screen).  

2. Select Preferences on the left side menu.  

3. Select Scheduling. 

4. In the field next to Scheduling permission type in the names of the people who you want to schedule WebEx 

5. Select Save at the bottom when you are done.  

MSalah@uchc.edu 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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1. Sign in at uconnhealth.webex.com with your @uchc.edu email and password (click the blue Sign In button at the top 

right of your screen).  

2. Select Preferences on the left side menu.  

Alternate Host for Personal Room 

3. Select My Personal Room. 

UConn Health’s Personal Room 

4. Scroll down to the bottom of the page and select the checkbox Let others host my Personal Room meetings without me. 

5. Select the radio button Let me choose alternate hosts of my Personal Room meetings. 

6. Enter in the field provided the @uchc.edu email addresses of who you want to give permission to be an alternate host for your 

Personal Room meetings. NOTE: they must have an uconnhealth.webex.com account and be verified. 

7. Select Save when you are finished. 

Enter emails here 

Note: These settings only work for a WebEx Personal Room. If you are scheduling WebEx meetings with a password and you want 

to assign alternate hosts, you need to assign each time within the meeting preferences when you are creating the meeting. 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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Add Alternate Host or Anyone with a Host Account can Host 
1. Sign in at uconnhealth.webex.com with your @uchc.edu email and password (click the blue Sign In button at the top 

right of your screen).  

2. Select Meetings on the left side menu.  

3. Select Schedule (grey icon at top right)  

4. If scheduling a meeting on behalf of someone else, select the person ’s name next to Schedule for. Note: This option 

will not appear if you don’t have permission to schedule on someone ’s behalf. 

5. Invite Attendees in the Attendees field.  

6. To assign an attendee as an alternate host, click on the icon of a person between their name and the “x”. The icon will turn 

blue notifying you they are assigned as a alternate host. 

7. To let the first person to join the meeting host, select Show advanced options then Scheduling Options. Note: Must have 

@uchc.edu email and be verified with WebEx. 

8. Select Let anyone with a host account on this site or anyone joining from an authenticated Cisco video device in this organiza-

tion host my meeting. This will allow the first person who joins the meeting to start, host and end the meeting. If the origi-

nal host joins they will take over as the host.  

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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Add Alternate Host when Scheduling through Outlook 
1. Open your Outlook desktop application  

2. Select Schedule Webex Meeting  

3. Select OK at the bottom of the popup window (WebEx settings window)  

4. Invite people in the To field by entering their email addresses  

5. Select Change Settings (after entering emails)  

6. Select Resources 

7. Select who you want to be an alternate host by clicking the checkbox next to their name. You may select multiple 

people as alternate hosts. Select OK when you are finished selecting alternate hosts. NOTE: Alternate hosts must have a 

verified account. 

8. Send your meeting invitation out when you are ready. If someone can NOT be an alternate host the system will 

give you a warning. You may go back and change your selection or ignore the message and send out the invitation.  
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Install Webex on a Smart Phone 

1. Download and install the WebEx app on your mobile device.   

a. The WebEx mobile app is available for Android and iOS devices. Click on the appropriate link to download 

the app.  

i. WebEx Mobile App (Android)  

ii. WebEx Mobile App (iOS)  

2. Open the WebEx app.  

3. If you are asked which WebEx site you would like to use, enter:  uconnhealth.webex.com 

Choose “uconnhealth.webex.com” 

Jane Doe@uchc.edu 

Cisco WebEx 

Meeting Icon 

Meeting  

Information 

Start a Personal 

Room Meeting  

4. Click on the grey  i icon at the top of your screen  i 

Join a Meeting 

(You must have meeting 

information to join) 

https://play.google.com/store/apps/details?id=com.cisco.webex.meetings&hl=en_US
https://apps.apple.com/cy/app/cisco-webex-meetings/id298844386
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5. Find your meeting URL. This is the link you will want to share with those who want to join your meeting. This link will 

be the same across all devices you use to host.  

6. Return to the previous screen and click on the green  START MEETING button to begin your meeting.  

123 
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Join a WebEx Meeting by Phone as Attendee or Host 

1. Sign in to your email. 

Attendee 

2. Find the WebEx email invitation for the meeting you want to join.  

3. Find the Join by phone numbers and the Access code.  

123 456 789 

6. You are now connected to the meeting. Use your phone’s mute button if you don’t need to speak. 

4. Dial the Join by phone number, there may be multiple options, choose any number. 

5. Enter the access code of the meeting and press #. 
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Host 

2. Find your meeting information next to More ways to join and select the circle with three dots in it. This will display all your per-

sonal room meeting information. This information does not change unless you manually it change in your settings (not recom-

mended).  

1. Sign in at uconnhealth.webex.com 

3. Dial the Join by phone number, there may be multiple options, choose any number 

4. Enter the access code of the meeting and press #. 

5. When prompted for the Host Pin, enter the Host PIN and press #. 

If you’re away from your computer, you can start your Instant or Personal Room meetings by phone without having to log in using 

the Cisco WebEx Meetings application. Start and host the meeting from any phone. 

6. Your meeting has started and you are the host. When you hang up the meeting will automatically end in five minutes. If you 

have assigned an alternate host, they will become the host. 

 Phone Number 

 Access Code 

 Host Pin 1234 
123 456 789 

123.456.7.89 

1234. 

123 456 789 

 

https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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Securing your WebEx Meeting 

Mute Participants on Entry 
Ensure participants are on mute as soon as they enter the meeting so that the main presenter can be uninterrupted upfront. If nec-

essary, the user can un-mute themselves at a later time or the meeting host can un-mute them.  

Running meeting from Desktop App: 

Running meeting from a web browser: 

Instructors can use features and setting in WebEx to ensure a secure, professional environment for their online class. We advise 

you to schedule meetings for added security. Scheduling adds a passwords and creates a unique invite so only people with the cor-

rect information can join. 

Please use the WebEx Meetings Desktop App when hosting a class. The Web App does not have the full suite of Host controls.  
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Disable “Anyone can Share” 

Avoid unauthorized screen/application sharing by un-checking “Anyone can share”. If necessary, the host can designate specific 

users as presenters in the course of the meeting.  

Lock your meeting room 

Once all the participants are in the meeting, the host can lock the meeting. Anyone trying to join after the meeting room has been 

locked will be placed in the lobby and will require authorization to enter the meeting.  
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Locking/Unlocking a Personal Room or Meeting as Host 

***IMPORTANT*** If a user is attempting to join a locked meeting using a telephone line, they will be automatically denied access 

without alerting the host. To admit a call-in user, the Meeting must be temporarily unlocked. 

For the user to appear in the Lobby, they must connect using an internet connection. 

1. While in the Meeting, move your cursor across the window so that the buttons appear along the bottom of the Meeting window.  

2. Click on the button with three vertical dots. The button is next to the red Hang Up button  

3. Click on the Lock meeting option.   

4. The icon in the upper right-hand corner indicates whether or not the meeting is locked.  

5. Repeat Steps 1 through 3 to unlock the room.  



 37 

Lock video view 
To avoid users being distracted by other participants, pin the video of the presenter for everyone in the meeting.  

Learn about the participant panel 

In the event a participant is disruptive there are several actions the host can take. These are available by right clicking on the user 

in the participant panel. The key ones are Mute, Stop Video, and in extreme cases, Expel. If the room is locked, the user will not be 

able to return, unless authorized by the host.  
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Adjust the Personal Room Automatic Lock 

Adjusting the Auto-Lock of a Personal Room 

1. Navigate to http://uconnhealth.webex.com/. Click the blue button at the top right of your screen Sign In.  

2. After signing in, you will be brought to your WebEx Home page. 

3. Click on Preferences in the left menu. 

4. Click My Personal Room. In this tab you will find options to enable/disable the auto-lock. You may also change how long We-

bEx waits before locking the Personal Room.  

Change how long WebEx 

waits before locking 

your Personal Room 

Enable/Disable 
auto-lock 

Click on the 
“My Personal Room” 

tab 

http://uconnhealth.webex.com/
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Managing Participants 
Hosts may manage participants within a WebEx meeting to maintain a professional atmosphere and control of the meeting by us-

ing the lobby. The lobby is a holding place for meeting participants where they cannot directly interact with others in the meeting. 

Hosts may move participants to the lobby so that they have to be manually re-admitted when appropriate. If a uninvited guest 

attends or a participant becomes disruptive, hosts can also expel this person. 

Adjusting the Auto-Lock of a Personal Room 
Scenario: You are hosting a Locked Meeting on a computer and someone is trying to Join.  

When your meeting is locked and someone tries to join, you will see the notification shown above. You have the option of ad-

mitting them without unlocking the meeting, or you may dismiss them by clicking on the small "x" to the right of the admit button. 

Moving Participants to the Lobby of a Personal Room 
You may move a participant back into the lobby from the Personal Room. To the participant, it will look as if they tried to join a 

locked meeting and are waiting to be admitted. Users in the lobby cannot communicate with others in the lobby, and they will not 

know if anyone else in the lobby.  

 The Lobby feature is only available to Personal Rooms. If a participant tries to join a locked scheduled meeting, they will be 

rejected without notifying the Host. 

 If you are using the Desktop App, right click on the participant you would like to move. 

 If you are using the Web App, left click on the participant you would like to move. Then click on the ellipses button that ap-

pears by their name, and click "Move to Lobby." 

Desktop App Web App 

picture of a user trying to join the room but appearing as an or-

ange banner above the participant list  

picture of a user trying to join the room but appearing as an or-

ange banner above the participant list  

Desktop App Web App 
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Expelling a Participant 

Participants may be expelled from the meeting by the host. Use of expulsion and the room lock will prevent uninvited participants 

from interrupting the meeting. 

1. While in the meeting, move your cursor across the window so that the buttons appear along the bottom of the meeting window.  

2. Click on the icon that looks like a person to open the Participant Panel. The icon sits 5th in line from the left. 

A. If you are using the Desktop App, right click on the Participant you would like to Expel.  

B. If you are using the Web App, left click on the Participant you would like to Expel. Then click on the ellipses button 

that shows in line after their name.  Click Expel to remove the participant.   

Desktop App Web App 

Right Click on 

the Participant 

Click Expel 

Right Click on 

the Participant 

Click Expel 



 41 

Audio Conference Line 

Click here for further assistance. 

To... Enter... 

Hear all keypad commands ** 

Mute your audio *6 

Play the participant count *# 

Unmute your audio *6 

To... Enter... 

Let participants continue the meeting without the host *8 (then hang up) 

Lock the meeting; prevents anyone else from joining *5 

Mute all attendees ## 

Send an email reminder *7 

Unlock the meeting *5 

Unmute all attendees 99 

Below are functions available during audio only conference. These functions are not available after starting the online portion of 

your personal conference meeting. 

Host Only: 

Host and Attendees: 

WebEx allows you to create and store up to three Personal Conference numbers for your WebEx account. These Personal Confer-

ence numbers are for Audio Only meetings (call-in only meetings). You can schedule a “Personal Conference Meeting” through the 

WebEx outlook integration tool. You must setup one of the Personal Conference Meeting numbers at uconnhealth.webex.com be-

fore scheduling. NOTE: You can start a meeting on your phone using the WebEx app allowing for call ins and joining by a computer. 

1. Sign in at uconnhealth.webex.com 

2. Select Preferences on the left menu 

3. Select Audio and Video 

5. Now you can generate a personal account number, next to Personal Conferencing select Generate an account. 

You have now created a Personal Conferencing number. Example below: 

Call this number to 
start your meeting 

Enter the Host access code if you are 
hosting when prompted. Then enter 
the Host Pin (Audio PIN) when 
prompted. 

Attendee access code, attendees will 
enter when prompted. 

4. Create an Audio PIN, follow the instructions given (you may use the same pin found under Preferences > My Personal Room > 

Host Pin). Select Save at the bottom of the page after enter your Audio Pin. 

https://help.webex.com/en-us/n84ij8t/Schedule-a-Personal-Conference-or-Audio-Only-Cisco-Webex-Meeting#task_jnp_3ll_dy
https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
https://uconnhealth.webex.com/webappng/sites/uconnhealth/dashboard?siteurl=uconnhealth
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Annotate in Cisco Webex Meetings 

Use text, lines, shapes, and color options from the Annotate toolbar to draw attention to things you want to point out on content 

that’s being shared.  

You can annotate several things in your Webex meetings, for example, you can share your screen and annotate whatever is visible 

on it. You can also upload a document or add a whiteboard to the meeting to annotate with your meeting participants. Learn more 

about sharing content here: Share Content in Cisco Webex Meetings.  

Before you can start annotating, you need to enable the Annotate toolbar. Choose one of the options below to enable your Anno-

tate toolbar:  

 If you're sharing your screen, go to the Controls panel at the top of your screen and click Annotate.  

 If you're sharing a document or a whiteboard, but not your screen, click Annotate on the Controls panel on the left. 

Share a Document to Annotate in Webex Meetings 

1.  Click File > Open and Share.  

2.  Navigate to the location of your file.  

3.  Select the file and click Open. 

To change which page you're viewing you can: 

 Select the page you want to view by clicking on the page thumbnail. 

 Select a page thumbnail then use the up and down arrows on your keyboard. 

 Click the arrows above and below the current page number from the small toolbar on the left. 

 Click the page number in the small toolbar on the left and enter the page you want. 

4.  To stop sharing click the drop-down arrow next to the document name, then click the close button. If you're sharing multiple 

documents, you must do this for each of them.  

      = Close 

      = Rename 

https://help.webex.com/5ddww5/
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Allow Participants to Annotate 

1.  To allow all participants to annotate content, during the meeting, event, or training session, on the Participant menu,            

select Assign Privileges, select Participants, and check the Annotate check box.  

2.  To allow a specific participant to annotate, in the Participants list, right-click the person's name and select Allow to Annotate.  

You can also use the annotate toggle              from the Annotate toolbar to enable or disable annotations for all meeting partici-

pants. If you click the right arrow, you can enable annotations for specific meeting participants.  
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Hosts can annotate shared content. If you're a participant and the host allows you to annotate shared content, you can draw on 

and add shapes to content that’s being shared too.  

Draw an Annotation 

1.  To draw an annotation, select one of the options on the Annotate toolbar. 

2.  Press the left mouse button and drag the mouse to draw. You can draw consecutive annotations. 

Make sure that your cursor is in draw mode and not move mode           . For example, if you selected the square shape on the 

toolbar, move your cursor until it changes to the draw cursor            . 

If you want to continue to draw directly on top of the annotation you just drew, hold down the Ctrl key in Windows (Command key 

on a Mac) to force the cursor into draw mode, press the left mouse button, and drag to draw.  

Move an Annotation 

Only the participant with the presenter role can move annotations. 

Learn how to pass the presenter role here: https://help.webex.com/WBX1800/  

1.  To move a shape, hover over the border of the shape until your cursor changes to the move cursor           , and then drag the 

shape to its new location.  

2.  To move a line, pen drawing, or text, hover directly over it until your cursor changes to the move cursor          , and then drag the 

annotation to its new location.  

Save an Annotated Whiteboard or Document 

Note: All unsaved documents and whiteboards will be lost once the meeting ends.  

1.  Choose the whiteboard or document you want to save from the list.  

2.  Click the Save           button from the Annotate toolbar on the left.  

3.  Navigate to where you want to save the file.  

https://help.webex.com/WBX1800/
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4.  Name the file and choose a file type. Available file types are: 

 Universal Communication Format (*.ucf)—choose if you want to reuse in a Webex meeting and continue annotating. 

 Portable Document Format (*.pdf)—choose if you want to open in other applications, print, or share. 

5.  Click Save.  

Annotate Toolbar 

Use the annotation tools to annotate your shared content.  

Tool Description 

 

 

Click to enable and disable annotation for all participants. 

Click > to expand the Annotate menu where you can enable specific participants to annotate. 

 

 

Draw attention to specific a point on the screen by using a pointer. The arrow pointer includes your 
name . 

 

If you're on Windows, click the arrow to select the laser pointer. 

 

 

Add text to shared content. 

Change the color by selecting  first. 
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Draw straight lines to underline content or draw attention to it. Drag your mouse to draw a line. 

If you're on Windows, click the arrow and select single or double arrowhead. 

 

Change color by selecting  first. 

 

 

Draw a square. 

If you're on Windows, click the arrow to draw an oval, check mark, or x mark. 

 

Change the color by selecting  first. 

 

 

Draw freehand using the pen. 

If you're on Windows, click the arrow to draw with a pencil. 

 

Change color by clicking  first. 
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Change the color of text, lines, shapes, and the pen or pencil tool. 

Click the arrow to select a color. 

 

 

 

Erase an annotation by selecting the eraser and then selecting the annotation. 

If you're on Windows, click the right arrow to erase all annotations or only theirs. 

 

 

Save your annotations. 

Unsaved annotations are lost when the meeting ends.  

Note: Unsaved annotations are lost when the meeting ends.  
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Webex Breakout Sessions 

You can use breakout sessions in meetings to place your participants into smaller groups where they can collaborate and share 

ideas. Breakout sessions are smaller groups that are split off from the main Webex meeting. They allow a subset of meeting partici-

pants to collaborate and share ideas over audio and video. Use breakout sessions for workshops, classrooms, or for when you need 

a moment to talk privately with a few participants, outside of the main meeting. Hosts and cohosts create breakout sessions, assign 

participants and then, when they're ready, start the sessions. Attendees can share content and use collaboration tools such as 

Chat, to collaborate in smaller, more focused discussion groups. 

Audio and Video in Breakout Sessions 

Each breakout session is a separate audio and video conference. If you connected to audio when you joined the meeting, it switch-

es over automatically when you join a breakout session. You can mute or unmute your audio and start or stop your video at any 

time during the breakout session, just like you would in the main session.  
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Create Breakout Sessions 

As a host or cohost, breakout sessions are easy to create. You can create the sessions any time during the meeting and then, when 

you're ready, start them.  

1.  Enable the breakout session feature: From the Breakout menu, click Enable Breakout Session.  

You can also enable the breakout session feature when you schedule a meeting. 

When the breakout session feature is enabled, the Breakout sessions button appears in the meeting controls. 

2.  Click Breakout sessions.  

Note: Only one host or cohost can have the Breakout session assignment dialog box open at a time. If the Breakout Session button 

is unavailable, someone else is editing the breakout sessions. Ask the host or cohost if they're making changes.  

3.  Select the number of breakout sessions that you want to create and how you would like to assign your participants:  

 Automatically: Let us split your participants up evenly into each of the breakout sessions.  

 Manually: You assign participants to each breakout session. 

4.  Click Start assignments.  

Note: The breakout sessions are created. By default, breakout sessions are named Breakout session 1, Breakout session 2, and so 
on. You can rename the breakout sessions later.  

https://help.webex.com/ns4eq3e/
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If you chose Automatically in Step 3, the participants are assigned. If you chose Manually in Step 3, assign participants to breakout 
sessions. 

Note: If you want to change the number of breakout sessions or how the participants were assigned, click Reset and repeat Steps 3 
and 4. The new breakout sessions replace all existing sessions.  

5.  Change breakout session settings.  

6.  When you're ready to start all breakout sessions, click Start breakout sessions.  

If the breakout sessions aren't set to end automatically after a specified number of minutes, you can end all breakout ses-
sions when you're finished using them.  

https://help.webex.com/n4jhmhe/
https://help.webex.com/n4jhmhe/
https://help.webex.com/t45occ/
https://help.webex.com/79kb4z/
https://help.webex.com/79kb4z/
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iPad 
1.  Tap More Options                    > Breakout Session.  

2.  Select the number of breakout sessions that you want to create and how you would like to assign your participants:  

Automatically: Let us split your participants up evenly into each of the breakout sessions.  

Manually: You assign participants to each breakout session. 

3.  Tap Create Assignments. 

By default, breakout sessions are named Breakout session 1, Breakout session 2, and so on. You can rename the breakout sessions 
later. 

If you chose Automatically in Step 2, the participants are assigned. If you chose Manually in Step 2, assign participants to breakout 
sessions.  

Note: If you want to change the number of breakout sessions or how the participants were assigned, tap Reset            and repeat 
Steps 2 and 3. The new breakout sessions will replace all existing sessions.  

5.  When you're ready to start all breakout sessions, tap Start Breakout Sessions.  

4.  Change breakout session settings.  

https://help.webex.com/ns4eq3e/
https://help.webex.com/n4jhmhe/
https://help.webex.com/n4jhmhe/
https://help.webex.com/t45occ/
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Change Breakout Session Settings 

As a host or cohost, you can choose to have all breakout sessions end automatically, after a specified number of minutes. You can 
have attendees join the sessions automatically, when the sessions start, or allow them to join themselves.  

IMPORTANT! Make sure that you change the settings before the breakout sessions start. You can't change the settings after the 
sessions have started.  

1.  If the Breakout session assignment dialog box isn't already open, click Breakout sessions to open it.  

2.  Click Settings.  

Allow attendees to return to main meeting: Check this setting if you want to allow attendees to be able to leave the breakout 

sessions and return to the main meeting at any time. 

Uncheck this setting if you want attendees to remain in the breakout session until the breakout sessions end or you ask all to re-

turn.  

Allow attendees to join breakout sessions later: Check this setting if you want attendees to receive a message that they've been 

invited to a breakout session but allow them to join the sessions on their own.  

 

 

 

 

Uncheck this setting if you want attendees to be moved automatically into the breakout sessions after the sessions start.  

 

 

Automatically close breakout sessions after: check this setting if you want breakout sessions to end automatically after a speci-

fied time. Enter the duration in minutes. Otherwise, you'll need to end all breakout sessions manually.  

Show countdown warning before closing breakout sessions: check this setting if you want to give attendees some time to wrap 

up before the breakout sessions end. Select the countdown duration.  

Uncheck this setting if you want the breakout sessions to end and attendees to return to the main meeting immediately after you 

end all breakout sessions.  

Popup window when breakout 

sessions starts automatically 

Popup window when 

breakout sessions start if 

joining breakout session later 
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End All Breakout Sessions 

As a host or cohost, you can end all breakouts sessions. When you end all breakout sessions, everyone who's in a breakout session 

returns to the main meeting automatically.  

1.  If the Breakout session assignment dialog box isn't already open, click Breakout to open it.  

Note: Only one host or cohost can have the Breakout session assignment dialog box open at a time.  

2.  Click End all breakout sessions > End sessions.  

Attendees see a message when you end all breakout sessions. This will send all attendees back to the main meeting session. 

You may start the breakout rooms again by selecting Breakout sessions --> Start Breakout sessions 
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Ask All Participants to Return to the Main Meeting 

As a host or cohost, you can send a message to participants in all breakout sessions, asking them to return to the main meeting.  

Participants can choose to return to the main meeting or stay in the breakout sessions. 

Participants who return to the main meeting can rejoin the breakout sessions later, if the breakout sessions aren't ended. 

Note: If you don't end the breakout sessions when you ask all to return, the participants' audio is muted when they return to the 

main meeting. Remind participants to unmute if they have something to say.  

1.  Select Breakout at the top of your screen 

2.  Select Ask All to Return 

3.  All attendees will receive a message asking them to Return to main meeting. They can select Return to return to the main 

meeting or Stay which will leave them in the current breakout session. 
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2.  From the All sessions drop-down list, select which sessions you want to broadcast the message to.  

3.  If you chose All sessions in Step 2, from the All participants drop-down list, select who you want to broadcast the message to.  

4.  Enter your message and click Send.  

Broadcast a message to breakout rooms or individuals 

As a host or cohost, you can share information with participants in one or all breakout sessions by broadcasting a written message 

to them. If you want to send a message to cohosts and presenters in all breakout sessions, you can broadcast a written message 

that only they'll see.  

1.  Click Broadcast in the Participants panel any time after the breakout sessions have started. If this option doesn't appear, Select 

Breakout drop down menu at the top of the screen then select Broadcast Message 

Choose a 

method 
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Meeting Features Available in Breakout Sessions 

Feature 
Meeting 
Host and 
Cohost 

Attendee 

Create and start breakout sessions 

 Maximum number of breakout sessions in a meeting: 100 

 The number of participants in a breakout session is limited by the meeting capacity of your 

plan. For example, for plans that allow 1,000 people, you can have 100 sessions with 10 peo-

ple in each, 20 sessions with 50 people in each, and so on. 

 Choose to assign participants automatically or manually. 

 Control how and when participants are allowed to return to the main meeting. 

  

Add, rename, or delete a breakout session   

Move or exchange attendees in breakout sessions   

Remove a participant from a breakout session   

Ask all participants to return to the main meeting 

If the breakout sessions aren't ended, the attendees' audio is muted when they return to the   

End all breakout sessions   

Feature Meeting Host and Cohost Attendee 

Join or leave a breakout session   

Start or stop your video during a breakout session   

Mute or unmute your audio during a breakout session   

Share content during a breakout session   

Use Chat to message others in your breakout session   

Ask for help during a breakout session   

Respond to a request for help in breakout sessions   

Broadcast a message in breakout sessions   

Participate in a Breakout Session 

For further assistance: https://help.webex.com/en-us/8cckd2/Manage-Breakout-Sessions-in-Cisco-Webex-Training 

https://help.webex.com/nft9foq/
https://help.webex.com/ns4eq3e/
https://help.webex.com/nuyqi6s/
https://help.webex.com/nupwcwv/
https://help.webex.com/ncgoz2y/
https://help.webex.com/79kb4z/
https://help.webex.com/nwz3a9cb/
https://help.webex.com/xrzfzj/
https://help.webex.com/1smrzv/
https://help.webex.com/n0z693t/
https://help.webex.com/en-us/8cckd2/Manage-Breakout-Sessions-in-Cisco-Webex-Training
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Change Your Name or Profile Picture 

1.  Sign in to your Webex site and mouse-over the down arrow beside your name. (top right of screen) 

2.  From the list, select My Profile.  

3.  To change only your profile picture, mouse-over it and select Change, then select Upload Picture.  

4.  To edit your profile, select Edit My Profile.  

5.  On the Edit My Webex Profile page, enter your First name and Last name as you want them to appear.  

Note: You can also change your profile picture on this page. Select Change profile picture and upload a new image.  

6.  Select Save.  

UConnHealthit@uchc.edu 

UCONNHealthIT 

Select an image from your files. 

For best results, use an image that is greater 

than or equal to 720 X 720 pixels and less than 

5 MB. 
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Start a Poll in Cisco Webex Meetings 
As a presenter, you can use a poll to create and share questionnaires. Polls can be useful for gathering feedback, taking votes, or 

testing knowledge.  

Create a Poll (Windows) 

1.  Select View > Panels > Manage Panels to add the Polling panel to your meeting. (You must be in a Webex meeting) 

2.  On the Manage Panels page, select Polling from the Available panels and click Add. Then, click OK.  

3.  Select the question type from the drop-down list in the Question section of the Polling panel. 

 Select Short answer if you want a poll with a type in short answer. 

 Select Multiple choice - Multiple Answers if you want a poll with multiple answers from a list of possibilities. 

 Select Multiple choice - Single Answer if you want a poll with one answer from a list of possibilities. 

4.  Click New to create a new question.  

5.  Type your question in the text box that appears and press Enter. In the text box that appears, type an answer to your question 

and press Enter.  

6.  (Optional) Repeat this process for as many questions and answers that you want to add.  

7.  Click Open Poll.  

Create Poll Prior to your Meeting 

1.  Start a meeting 

2.  Display the polling panel: 

A. Go to the View menu, then select Panels > Manage Panels…     

 The 'Manage Panels' window appears. 

A. In the Available panels: section, select Polling, then click the Add >> button. 

B. Click the OK button. 

3.  Create a poll with the desired questions, see: Manage Polls  

Webex Meetings doesn't offer a standalone poll editor. See the workaround below: 

https://collaborationhelp.cisco.com/article/en-us/3mglpu
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Create a Poll (Mac) 

1.  Select View > Panels > Manage Panels to add the Polling panel to your meeting. (You must be in a Webex meeting) 

2.  On the Manage Panels page, select Polling from the Available panels and click Add. Then, click OK.  

3.  Go to the Polling panel for each question and answer that you want to create. 

 Click the Add a Question            icon to add a new question. 

 Click the Add an Answer            icon to add a new answer. 

4.  Select the question type from the drop-down list in the Question section of the Polling panel for each question that you create. 

 Select Multiple Answers if you want to select multiple answers from a list of possibilities. 

 Select Single Answer if you want to select one answer from a list of possibilities. 

 Select Short Answer if you want to type in a short answer. 

5.  (Optional) Repeat this process for as many questions and answers that you want to add.  

6.  Click Open Poll.  

4.  Go to the File menu, then select Save > Poll Questions. 

5.  Choose a location to save the poll, enter a file name, then click the Save button. 

6.  In your next meeting, enable the polling panel using step 2 above. 

7.  Go to the File menu, then select Open Poll Questions…. 

8.  Select the previously created poll, then click the Open button. 
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Task Action 

Change the question type 

Windows: Select the question that you want to change and then select the new 
question type from the drop-down list. Click Change Type to enact the change. 

Mac: Select Click here to change question type which is displayed under each 
question. 

Delete a question or answer 
Select the question or answer, and then select the Delete  icon. 

Delete an entire question-
naire 

Select Clear All at the bottom of the Polling panel. 

Display a timer during polling 

1.  Windows: Select Options at the bottom of your Polling panel. 

Mac: Select the Options  icon on the lower-right portion of the Polling    

panel. 

2.  Check the Display check box, type the length of time in the Alarm box, and 

then click OK. 

 

 

Edit a question or answer Select the question or answer, click the Edit  icon, and then make your 

changes. 

Open a poll 

1.  Click Open Poll. 

2.  Click Close Poll to close your poll. If the poll is timed, it closes automatically. 

Open a poll questionnaire file 

to display the questionnaire 

on your Polling panel 
Select File > Open Poll Questions or select the Open  icon. 

Take a Poll Quick Reference Tasks 
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Rearrange questions or answers 
Select the question or answer, and then select the Move Up  or Move 

Down  icon. 

Save a poll questionnaire 
Select File > Save > Poll Questions or select the Save  icon. 

Save the results of a poll 
Select File > Save > Poll Results or select the Save  icon. 

Share poll results with partici-

pants 

In the Share with attendees section, check the Poll results check box or 

the Individual results check box, and then click Apply. 

View and share poll results 

By default only the presenter will see the results of the poll. 

To share the poll results with the attendee, select Share with attendees > Poll 
results > apply. 
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Raising Hand in Webex 

As a host or presenter, you can now see participants who raise their hand, automatically sorted at the top of the Participants list. 

The order that the participants are listed follows the order in which they raised their hand. You can also sort participants by name 

to quickly scan the list.  

1.  Select              to open the Participants panel.  

2.  Select Sort by > Raised hands  

Note: The participants who raised their hands are moved to the top of participant list automatically and are sorted in the order in 

which they raised their hands. The host and presenter remain at the top of the list.  

How to Raise your Hand 

 1.  Select              to open the Participants panel.  

2.  Find your name on the participants list. (Below your name you will see “me”) 

3.  Click on the          icon to raise your hand. It will turn blue, meaning your hand is raised. Click on the icon again to lower your 

hand. 

Calling on Participants with Raised Hands 

This symbol indicates that 

the participant has their 

hand raised. 

Sort by raised hands or 

names (alphabetical) 
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Virtual Backgrounds 
You can blur your background, change your background, or add a background image during your meeting, event, or training ses-

sion. Blurring your background makes your surroundings appear out of focus so people can't see the details of what's going on be-

hind you. Alternatively, you can completely replace your surroundings with one of the preset backgrounds, or add one of your own.  

Before You Join 

Click Change Background and then do one of the following: 

 To blur your surroundings while remaining in focus, click Blur. 

 To use a default virtual background, click the one you want. 

 To use your own image for the virtual background, tap the + icon. 

Note: We recommend that you use an image that's 1280 × 720 pixels in size or larger. Images must be in the .jpg or .png format. 

1.  In your self-view window, click the Video options icon, choose Change Virtual Background, and do one of the following: 

 To blur your surroundings while remaining in focus, click Blur. 

 To use a default virtual background, click the one you want. 

 To use your own image for the virtual background, tap the + icon. 

2.  When you're ready for everyone in the meeting to see your background, click Apply. Webex remembers your selection for your 

next meeting.  

These tips can help make sure you distinguish yourself from your surroundings so that you get the most out of using virtual back-
grounds. 

 Make sure the area you're in is well lit. 

 Sit in front of a wall or other static backdrop. 

 Wear clothes that are a different color than your surroundings. 
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iOS (Apple Devices) 

You can use virtual backgrounds in meetings, events, and training sessions using the Webex Meetings mobile app. You can change 

your background after you join.  

1.  Tap Video                , and then tap Virtual Background.  

2.  Do one of the following: 

 To blur your surroundings while remaining in focus, tap Blur. 

 To use a default virtual background, tap the one you want. 

 To use your own image for the virtual background, tap the + icon. 

Note: We recommend that you use an image that's 1280 × 720 pixels for landscape, and 1280x1920 pixels for portrait. Images must 

be in the .jpg or .png format. 

The image you choose saves to your computer or mobile device so you can use it again for later meetings. Images only save to the 

device you add them to. If want to use the same image on another device, you need to add it to your new device.  

3.  When you're ready for everyone in the meeting to see your background, tap Apply. Webex remembers your selection for your 

next meeting.  

1. Select camera icon 

2. Select Virtual Background 

3. Select an image for your 

virtual background 

4. Select Start my video 
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System Requirements for using Virtual Backgrounds 

Windows 

Webex Version: 

 WBS40.6.6—Blurred background and background replacement 

 WBS40.8 and later—Blurred background, background replacement, and custom backgrounds 

Operating System: 

 Windows 8 or Windows 10 32-bit/64-bit 

Processor: 

 Intel Core i3, i5, or i7 4000 series or higher 

 AMD Ryzen 5, 7, 9, or higher 

Memory: 

 4 GB or more of RAM 

 2 GB or more of VRAM for dedicated GPUs 

Mac 

Webex version: 

 WBS40.6.6—Blurred background and background replacement 

 WBS40.8 and later—Blurred background, background replacement, and custom backgrounds 

Operating system: 

 macOS High Sierra (version 10.13) and later 

Processor: 

 Intel Core i7 4000 series quad-core or higher processor 

 Intel Core i7 5000 series dual-core processor or higher 

 Intel Core i5 6000 series dual-core processor or higher 

Memory: 

 2GB or more of VRAM for dedicated GPUs 

iOS 

Webex version: 

 WBS39.8 and later 

Device: 

 iPhone 7 and later 

 iPad (5th generation) and later 

 iPad Pro and later 

 iPad mini (5th generation) and later 

 iPad Air (3rd generation) and later 
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Android 

Webex version: 

 WBS40.7 and later 

Operating system: 

 Android 9.0 (Pie) and later 

Processor: 

 Snapdragon 845 

 Samsung Exynos 9810 

 Equivalent processors with eight or more cores 

Memory: 

 3.5 GB or more of RAM 

Note: Only Android devices that meet these requirements are supported.  


